PUBLIC NOTICE
Federal Communications Commission
445 12th St., S.W.
Washington, D.C. 20554

News Media Information 202 / 418-0500
Internet: http://www.fcc.gov
TTY: 1-888-835-5322

DA 12-680
April 30, 2012
WIRELESS TELECOMMUNICATIONS BUREAU GRANTS
LOWER AND UPPER PAGING BANDS LICENSES
Auction 87
Report No. AUC-87 (Auction 87)
On August 6, 2010, the Federal Communications Commission completed an auction of licenses in
the Lower and Upper Paging Bands (Auction 87). 1 After a preliminary review of the FCC long-form
applications (FCC Form 601), the applications listed in Attachment A to this Public Notice were accepted
for filing. 2 Upon further review, we find that the applications listed in Attachment A are complete and
conform to the Commission’s rules. 3 Furthermore, the Commission has received full payment, as required
by section 1.2109(a) of its rules, 4 for the licenses listed in Attachment A.
Accordingly, by this Public Notice, we announce the grant of the licenses listed in Attachment A.
We grant these licenses pursuant to Section 309(a) of the Communications Act, 47 U.S.C. § 309(a), and
section 0.331 of the Commission’s rules, 47 C.F.R. § 0.331, because it will serve the public interest,
convenience, and necessity.
This Public Notice includes the following Attachments:
Attachment A: Applications and Licenses the Wireless Telecommunications Bureau Is Granting – Sorted
by Licensee.
Attachment B: Instructions for Searching for the Applications Listed in Attachment A Using ULS.
Attachment C: Instructions for Searching for Granted Licenses Listed in Attachment A Using ULS.
Attachment D: Instructions for Accessing the FCC Network Using Windows 95/98/2000/XP.
Please contact Kathy Harris, Wireless Telecommunications Bureau, Mobility Division, at (202)
418-0132, for questions regarding legal matters and licensing issues.
- FCC 1

See Auction of Lower and Upper Paging Bands Licenses Closes; Winning Bidders Announced for Auction 87,
Public Notice, 25 FCC Rcd 18164 (WTB 2010).

2

See Wireless Telecommunications Bureau Announces that Applications for Lower and Upper Paging Bands
Licenses Are Accepted for Filing, Public Notice, 25 FCC Rcd 13229 (WTB 2010).

3

The applications listed in Attachment A represent two of the 59 applicants filing long-form applications for Lower
and Upper Paging Bands authorizations following Auction 87.
4

47 C.F.R. § 1.2109(a).

ATTACHMENT A
UPPER AND LOWER PAGING BANDS
APPLICATIONS GRANTED
AUCTION ID: 87
SORTED BY: MARKET, CHANNEL BLOCK
DATE OF REPORT: APRIL 30, 2012

Licensee Name
Silke Communications, Inc.
Silke Communications, Inc.
Silke Communications, Inc.
Silke Communications, Inc.
Silke Communications, Inc.
Silke Communications, Inc.
Silke Communications, Inc.
Silke Communications, Inc.
Silke Communications, Inc.
Silke Communications, Inc.
Silke Communications, Inc.
Silke Communications, Inc.
Silke Communications, Inc.
Silke Communications, Inc.
Silke Communications, Inc.
Silke Communications, Inc.
Two Way Communications
Two Way Communications
Two Way Communications
Two Way Communications
Two Way Communications
Two Way Communications
Two Way Communications
Two Way Communications
Two Way Communications
Two Way Communications
Two Way Communications
Two Way Communications
Two Way Communications
Two Way Communications
Two Way Communications
Two Way Communications
Two Way Communications
Two Way Communications
Two Way Communications
Two Way Communications
Two Way Communications

Market Code
BEA150
BEA150
BEA150
BEA150
BEA150
BEA150
BEA150
BEA150
BEA150
BEA150
BEA150
BEA168
BEA168
BEA168
BEA168
BEA168
BEA080
BEA080
BEA080
BEA080
BEA080
BEA080
BEA080
BEA080
BEA080
BEA081
BEA081
BEA081
BEA082
BEA082
BEA083
BEA084
BEA084
BEA085
BEA085
BEA085
BEA085

Channel Block
FE
FF
FM
FO
GP
GQ
GR
GS
GV
GX
GY
GP
GQ
GR
GS
GV
GD
GE
GF
GH
GK
GM
GN
GU
GV
GE
GM
GY
GH
GV
GV
GG
GV
GD
GN
GU
GV

File Number
0004355886
0004355886
0004355886
0004355886
0004355886
0004355886
0004355886
0004355886
0004355886
0004355886
0004355886
0004355886
0004355886
0004355886
0004355886
0004355886
0004359102
0004359102
0004359102
0004359102
0004359102
0004359102
0004359102
0004359102
0004359102
0004359102
0004359102
0004359102
0004359102
0004359102
0004359102
0004359102
0004359102
0004359102
0004359102
0004359102
0004359102

Call Sign
WQPF307
WQPF308
WQPF309
WQPF310
WQPF311
WQPF312
WQPF313
WQPF314
WQPF315
WQPF316
WQPF317
WQPF318
WQPF319
WQPF320
WQPF321
WQPF322
WQPF286
WQPF287
WQPF288
WQPF289
WQPF290
WQPF291
WQPF292
WQPF293
WQPF294
WQPF295
WQPF296
WQPF297
WQPF298
WQPF299
WQPF300
WQPF301
WQPF302
WQPF303
WQPF304
WQPF305
WQPF306

Intent To Seek A
Tribal Lands
Bidding Credit
N
N
N
N
N
N
N
N
N
N
N
N
N
N
N
N
N
N
N
N
N
N
N
N
N
N
N
N
N
N
N
N
N
N
N
N
N

Attachment B
SEARCH INSTRUCTIONS FOR LOWER AND UPPER PAGING BANDS
LICENSE APPLICATIONS
This attachment provides instructions for electronically searching the FCC Network for a
specific application or applications on file with the Commission. The following instructions
relate specifically to searching for applications filed in response to Auction 87.
To search the FCC Network for an application, you must first connect to the FCC Network.
Attachment C describes how Windows 95/98/2000/XP users can connect to the FCC Network
using the Dial-Up Networking features of Windows 95/98/2000/XP.
We recommend that you use Netscape Communicator 8.1 or higher, or Internet Explorer 6.0 or
higher (Internet web browser software) to use ULS for application searches. To download the
latest versions of Netscape Communicator or Internet Explorer free of charge, access the
Netscape download site at http://home.netscape.com/download/, or the Microsoft Internet
Explorer download site at: http://www.microsoft.com/windows/ie/downloads/default.asp.

Conventions
The instructions in this attachment use the following typographic conventions:
bold

Represents objects on the screen that you click with the mouse pointer, including
buttons, Internet links, icon, tabs, menu items (e.g., Cancel button, Auctions link,
Save option in the File menu).

italic

Represents field names or areas of a screen (e.g., Licensee Name field, Applicant
Information area of a screen).

bold italic

Represents characters that you must type exactly as they appear in the
instructions. For example, if you are instructed to type http://www.fcc.gov, you
should type all of the characters shown in bold italic exactly as they are printed.

SMALL CAPS Represents keys on the keyboard (e.g., ENTER, CTRL, ESC).
Note: Throughout these instructions, “enter” means to type the appropriate information and then
press the ENTER key.
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Performing an Application Search
Once you have connected to the FCC Network, follow the procedures below to search for an
application. You may click the ? (Help) button at any time for additional information on using
Application Search.
1.

Connect to the FCC Network using one of the following options:
Note: If your PC is connected to a network, you must use a secure proxy to access the
FCC Network. Consult your Network Administrator.
Dial-Up Access
a.

Use Dial-Up Networking in Windows 95/98/2000/XP to connect to the FCC
Network (see Attachment D).

b.

Start your web browser. In the location field of the web browser screen, type
http://wtbwww05.fcc.gov. Then press the ENTER key.

Internet Access
a.

Start your web browser and connect to the Internet using your Internet Service
Provider.

b.

In the location field of the web browser screen, type http://wireless.fcc.gov/uls/.
Then press the ENTER key.

2.

Verify that Java and JavaScript are enabled in your web browser preferences.
Additionally, the preferences must specify “Accept all cookies.” Refer to your web
browser Help facility for more information.

3.

On the Universal Licensing System main page, click the Applications button, located in
the center of the page.

4.

For a quick search, use the drop down list in the center License Search box to search by a
specific Call Sign, FRN or Licensee Name. You can choose the Advance Search option
to search by various criteria.
You can conduct an Advanced Application Search to specify search options by Applicant
State, ZIP, and Name; Dates (Receipt, Action, etc.); Application Status; Application
Purpose; and more.
Also shown are the options for various Non-Auction service specific searches: Aircraft,
Amateur, Commercial/Restricted Permits, GMRS and Ship.
You have the option to conduct a Specialized Search with the following options:
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5.

•

Select Market Based to search only for licenses associated with an FCC Auction.

•

Select Site Based to search only for site-based licenses.

•

Select Frequency to search for Wireless licenses based on a single frequency or
frequency ranges.

•

Select Facility ID to search by facility identification number.

•

Select Geographic to search by coordinates, county/state, address, and frequency
information.

•

Select Link Registration ID to search by the link registration identification number.

•

Select NG Number to search by the Interdepartment Radio Advisory Committee
(IRAC) coordination number.

•

Select Transfers and Assignment Search to search by Assignment information,
transfer information, date information and more.

•

Select Ownership Search to search Ownership Disclosure Filings by Filing Type,
Filing Status and more.

The appropriate Application Search screen appears. This screen contains several data
entry fields used for specifying the criteria for your application search. Specify the
search criteria necessary to locate the desired application. Please refer to the following
“Basic Guidelines for Specifying Search Criteria” for more information.
If you are searching for an application filed for Auction 87, click 87 in the Auction ID
field.
Basic Guidelines for Specifying Search Criteria:
•

You must specify search criteria in at least one field. You do not have to specify
search criteria in all of the search fields. Enter search criteria into as many fields
as you wish.

•

To specify search criteria in a search field containing a menu of options, click the
desired option from the menu. Use the scroll bars to view all options in a menu.
You can select multiple options from a menu by pressing the CTRL key while you
click the menu options.
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•

Click the Reset button to undo a menu selection and search for all options in the
menu.

•

Click the Clear button to reset entries in all of the search fields.

Click the ? Help button for a definition of each search field available on the Application
Search screen.
6.

After you have specified the desired search criteria, click the Search button. The system
will scan the database for any applications matching the search criteria. The matching
application files will be listed on the Search Results screen. The Search Results screen
will identify the file number, licensee name, application purpose, application status, radio
service code, and receipt date for each application returned in the query.
A message on the Search Results screen will indicate if no matches were found for the
specified search criteria. Click the New Search button and re-specify search criteria.

7.

To view an application, click its file number link. To navigate through the data on the
Application screen, use the scroll bar or click the links at the top of the screen. Click the
? Help button for information regarding specific functions available on this screen.
•

To re-access the Search Results screen, click Return to Results at the top of the
screen.

•

To begin a new search, click New Search at the top of the screen.

Technical Support
For technical assistance in searching the ULS for applications, contact the FCC Technical
Support Hotline at (202) 414-1250 (voice) or (202) 414-1255 (TTY). The FCC Technical
Support Hotline is generally available Monday through Friday, from 8 a.m. to 6 p.m. EST. All
calls to the FCC Technical Support Hotline are recorded.
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Attachment C
SEARCH INSTRUCTIONS FOR GRANTED
LOWER AND UPPER PAGING BANDS LICENSES
AUCTION 87
Following are instructions for electronically searching the FCC Network for a specific license or
licenses on file with the Commission. The following instructions relate specifically to searching
for granted licenses associated with Auction 87.
To search the FCC Network for an application, you must first connect to the FCC Network.
Attachment D describes how Windows 95/98/2000/XP users can connect to the FCC Network
using the Dial-Up Networking features of Windows 95/98/2000/XP.
We recommend that you use Netscape Communicator 8.1 or higher, or Internet Explorer 6.0 or
higher (Internet web browser software) to use ULS for license searches. To download the latest
versions of Netscape Communicator or Internet Explorer free of charge, access the Netscape
download site at http://home.netscape.com/download/, or the Microsoft Internet Explorer
download site at: http://www.microsoft.com/windows/ie/downloads/default.asp.
Conventions
The instructions in this attachment use the following typographic conventions:
bold

Represents objects on the screen that you click with the mouse pointer, including
buttons, Internet links, icon, tabs, menu items (e.g., Cancel button, Auctions link,
Save option in the File menu).

italic

Represents field names or areas of a screen (e.g., Licensee Name field, Applicant
Information area of a screen).

bold italic

Represents characters that you must type exactly as they appear in the
instructions. For example, if you are instructed to type http://www.fcc.gov, you
should type all of the characters shown in bold italic exactly as they are printed.

SMALL CAPS Capital letters (in Roman without italics or bold lettering) inside French quotes
indicate specific keys on the keyboard (e.g., «ENTER,» «CTRL,» «ESC»).

1

Performing a License Search
Once you have connected to the FCC Network, follow the procedures below to search for a
license. You may click the ? (Help) button at anytime for additional information on using
License Search.
1.

Connect to the FCC Network using one of the following options:
Note: If your PC is connected to a network, you must use a secure proxy to access the
FCC Network. Consult your Network Administrator.
Dial-Up Access
a.

Use Dial-Up Networking in Windows 95/98/2000/XP to connect to the FCC
Network (see Attachment D).

b.

Start your web browser. In the location field of the web browser screen, type
http://wtbwww05.fcc.gov. Then press the ENTER key.

Internet Access
a.

Start your web browser and connect to the Internet using your Internet Service
Provider.

b.

In the location field of the web browser screen, type http://www.fcc.gov/wtb/uls.
Then press the ENTER key.

2.

Verify that Java and JavaScript are enabled in your web browser preferences.
Additionally, the preferences must specify “Accept all cookies.” Refer to your web
browser Help facility for more information.

3.

On the Universal Licensing System main page, click the License Search button, located
on the left side of the page.
Note: License Search utilizes "cookies". If you are receiving a notification message
when accepting a cookie, we recommend that you disable this message in your web
browser options. Please consult your web browser Help facility for more information.

4.

Select the type of search by clicking the down arrow in the Select Search Type field to
obtain a menu containing the following options:
Select General to search for all licenses.
Select Market Based to search only for licenses associated with an FCC Auction.
Select Site Based to search only for site-based licenses.
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Select Frequency to search for Wireless licenses based on a single frequency or
frequency ranges.
Click the desired option from the menu and click the Continue button.
5.

The License Search screen appears. This screen contains several data entry fields used
for specifying the criteria for your license search. On the License Search screen, specify
the search criteria necessary to locate the desired license. Please refer to the following
“Basic Guidelines for Specifying Search Criteria” for more information.
Basic Guidelines for Specifying Search Criteria:
You must specify search criteria in at least one field. You do not have to specify search
criteria in all of the search fields. Enter search criteria in as many fields as you wish.
To specify search criteria in a search field containing a menu of options, click the desired
option from the menu. Use the scroll bars to view all options in a menu. You can
select multiple options from a menu by pressing the CTRL key while you click the
menu options.
Click <No Criteria> to undo a menu selection and search for all options in the menu.
Click the Clear button to clear entries from all of the search fields.
The Universal Licensing System restricts the number of rows returned in a license search
to 3000. In such instances, you must enter more specific search criteria to reduce the
number of rows returned.
Click the ? (Help) button for a definition of each search field available on the License
Search screen.

6.

After you have specified the desired search criteria, click the Search button. The system
will scan the database for any licenses matching the search criteria. The matching license
files will be listed on the Search Results screen. The Search Results screen will identify
the call sign, licensee name, radio service code, market, and licensee ID for each license
returned in the query.
A message on the Search Results screen will indicate if no matches were found for the
specified search criteria. Click the New Search button and re-specify search criteria.

7.

To view a license, click its call sign underlined link. To navigate through the data on the
License screen, use the scroll bar or click the links at the top of the screen. Click the ?
(Help) button for information regarding specific functions available on this screen.
To re-access the Search Results screen, click the down arrow in the Other Options field
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to obtain the drop-down menu of options. Click Search Results from the Other
Options menu and then click the Go button.
To access additional information about the license (such as special conditions, associated
applications, and locations), click the down arrow in the License Options field to
obtain the drop-down menu of options. Click the desired selection from the menu
then click the Go button.
To begin a new search, click the down arrow in the Other Options field to obtain the
drop-down menu of options. Click New Search from the Other Options menu and
then click the Go button.

Technical Support
For technical assistance in searching the ULS for applications and licenses, contact the FCC
Technical Support Hotline at (202) 414-1250. The FCC Technical Support Hotline generally
will be available Monday through Friday, from 8 a.m. to 6 p.m. EST. All calls to the FCC
Technical Support Hotline are recorded.
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Attachment D
USING DIAL-UP NETWORKING IN
WINDOWS 95/98/2000/XP FOR ULS FILING
This attachment describes how to use Windows 95/98/2000/XP Dial-Up Networking to establish a
direct connection from your PC to the FCC Network and the Universal Licensing System (ULS) in
order to file or review the Form 601. This point-to-point connection is not routed through the
Internet.
This direct dial-up connection is NOT required to perform ULS online filing. You may file or review
Form 601 on the Internet by entering http://wireless.fcc.gov/uls in your Web browser’s
address/location bar and clicking the Online Filing button on the ULS homepage.

Conventions
The instructions in this section use the following typographical conventions:
bold

Represents objects on the screen that you click with the mouse pointer, including
buttons, Internet links, icons, tabs, menu items (e.g., Cancel button, Auctions link,
Save option in the File menu).

italic

Represents field names or areas of a screen (e.g., Applicant field, Selected Licenses
area of a screen).

bold italic

Represents characters that you must type exactly as they appear in the instructions.
For example, if you are instructed to type http://wireless.fcc.gov/uls, you should
type all of the characters shown in bold italic exactly as they are printed.

SMALL CAPS

Represents keys on the keyboard (e.g., ENTER, CTRL, ESC).

Note: Throughout these instructions, “enter” means to type the appropriate information and then
press the ENTER key.
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Hardware and Software Requirements
Connecting to the FCC Network using Windows 95/98/2000/XP Dial-Up Networking requires at a
minimum the following hardware and software:
Hardware Requirements
•
•
•
•
•

CPU: Pentium 133 or above
RAM: 32 MB (more recommended if you have multiple applications open)
Monitor: VGA or above
Modem: 28.8 Kbps, Hayes-compatible or faster (recommend 56.6 Kbps)
Mouse or other pointing device
Software Requirements

•

Web browser software is required. You may use Netscape Communicator (v. 4.5, 4.51, 4.61, 4.7x) or
Internet Explorer (v. 5.5 or later) browser software to electronically register and file FCC Form 601
through ULS. You can download Netscape Communicator free of charge by accessing the Netscape
download site at http://home.netscape.com/download/archive.html. You may also download Internet
Explorer at http://www.microsoft.com/windows/ie/downloads/default.asp.

•

Microsoft Windows 95/98/2000/XP
Note: If you are running Windows in a networked environment, check with your local network
administrator for any potential conflicts with Windows 95/98/2000/XP Dial-Up Networking.
This usually includes any TCP/IP installed network protocol.

•

Adobe Acrobat 4.0 Reader (or higher) is recommended as a plug-in to your browser. This
provides a viewer for displaying files related to applications, such as attachments and exhibits.
For best results, install the plug-in after you have installed the desired web browser. This will
allow the plug-in to be fully integrated within the browser window.
To download Adobe Acrobat version 4.0 or higher, access the Acrobat download site at
http://www.adobe.com/support/downloads/main.html.
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Configuring Dial-Up Networking
1.

To start dial-up networking in Windows 95/98:
a.
b.
c.
d.

Click the Windows 95/98 Start button.
Click the Programs option to display the Programs menu.
Click the Accessories option to display the Accessories menu.
In Windows 95, click Dial-Up Networking.
In Windows 98, click Communications, then Dial-Up Networking.

If Dial-Up Networking is not an option on your Accessories menu, you should install it from
your Windows 95/98 CD or diskettes.
To start dial-up networking in Windows XP follow the steps below.
a. Click the Start button.
b. Click the Programs option to display the Programs menu.
c. Click the Accessories option to display the Accessories menu.
d. Click Communications
e. Click New Connection Wizard.
f. Click Connect to the Network at My Workplace.
g. Click Dial-Up Connection.
h. Specify connection name by entering the name of the dial-up location in the Company
Name field, e.g. “FCC Dial-Up Connection.”
i. Enter dial-up phone number, 1-800-844-2784.
j. Select Connection Availability:
Anyone’s use
My use only
To start dial-up networking in Windows 2000, the user must be logged in as an
“administrator.” Follow these steps:
a.
b.
c.
d.

Click the Start button.
Click Settings.
Click on the Network icon.
Click on Dial-up Connections.

NOTE: You must have administrative rights in Windows 2000 or XP to set up dial-up
networking.
2.

When the Dial-Up Networking window appears, double-click the Make New
Connection icon.
The Make New Connection window appears.

3.

In the field entitled Type a name for the computer you are dialing, type ULS at FCC.

4.

In Windows 95, click the down arrow at the right of the Select a modem field and select your
modem from the menu of available modems.
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In Windows 98, click the down arrow at the right of the Select a device field and select your
modem from the menu of available devices.
If your modem does not appear on this list, you must install your modem driver according to
the modem manufacturer installation procedures, which are usually described in your
modem’s user manual.
5.

Click the Configure button. Click the Options tab at the top of the Properties window.

6.

In the Connection control area of the Options tab, verify that neither option is selected. If
either option is selected, click the check box at the left of the option to deselect it. Then
click the OK button.

7.

Click the Next button.

8.

Type 800 in the Area Code field and 844-2784 in the Telephone Number field. Verify that
the correct country is selected in the Country code field. If necessary, click the down arrow
at the right of the Country code field, and select the appropriate country from the menu of
available countries.

9.

Click the Next button.

10.

Click the Finish button. An icon titled ULS at FCC appears in the Dial-Up Networking
window.

11.

Verify that properties are configured correctly before attempting a dial-up session. Position
the mouse pointer on the ULS at FCC icon and click the right mouse button to display a
menu. Select Properties from the menu.

12.

Click the Server Types tab at the top of the Properties window.

13.

In the Advanced Options area, verify that only Enable software compression is selected.
If it is not selected, click the check box at the left of the option to select it. If either of the
other options is selected, click the check box to deselect it.

14.

In the Allowed Network Protocols area, verify that only TCP/IP is selected.
If it is not selected, click the check box at the left of the option to select it. If either of the
other options is selected, click the check box to deselect it.

15.

Click the TCP/IP Settings button. In the TCP/IP Settings window, confirm that the Server
assigned IP address option is selected. Then, in the section beneath, select Specify name
server addresses.
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16.

Type 192.104.54.1 as the Primary DNS.
Make sure that these two options are checked:
•
•

Use IP header compression
Use default gateway or remote network

17.

Click OK on the TCP/IP Settings window and the Server Type window.

18.

a.

Click the Windows 95/98 Start button, then click the Settings option to display the
Settings menu.

b. Click Control Panel and then double-click the Network icon.
c. In the Configuration tab of the Network window, select TCP/IP and click the
Properties button. (If there are multiple TCP/IP protocols, select TCP/IP, then highlight
Dial-Up Adapter and click Properties.)
d. Click the DNS Configuration tab.
e. Select Enable DNS. Type bidder in the Host box, type fcc.gov in the Domain box, then
type 192.104.54.1 in the DNS Server Search Order box and click the Add button.
f.

Click OK on the TCP/IP Properties windows, then click OK on the Network window.

g. If you are prompted to restart your computer, click Yes to restart, then begin the Dial-Up
Procedure.
Dial-Up Procedure
1.

If the Dial-Up Networking window is not currently open, do the following:
a.
b.
c.
d.

Click the Windows 95/98 Start button.
Click the Programs option to display the Programs menu.
Click the Accessories option to display the Accessories menu.
In Windows 95, click Dial-Up Networking
In Windows 98, click Communications, then Dial-Up Networking.

The Dial-Up Networking window appears.
2.

Double-click the ULS at FCC icon in the Dial-Up Networking window.

3.

Click the Connect button on the window. Do not enter User name and Password.
The Connecting window appears, indicating the status of your connection as your modem dials
into the system. This window must remain running during your dial-up session. You may
minimize the window, if you wish.
If your modem fails to establish a connection, please see the Troubleshooting section below.
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4.

Once the connection is established, open your Web browser.

5.

In your browser’s location field, enter http://wireless.fcc.gov/uls/
If nothing appears in your Web browser, see the Troubleshooting section below.

6.

When you have finished, exit the Web browser, then click the Disconnect button on the
Connecting window to end your dial-up session.
Troubleshooting

Following are problems you may encounter and possible solutions for resolving or isolating them.
Modem does not respond
1.

Confirm that all physical connections for the modem are present.

2.

Confirm that the phone line is active by connecting it to a telephone and checking for a dial
tone.

3.

Confirm that the correct modem driver is installed for your modem.

Modem dials but does not connect
1.

Confirm that the number the modem is dialing is correct.

2.

Confirm that the modem prefix, if any, is correct.

Modem dials and connects, but nothing appears when you enter the location in the Web
browser
1.

Check the settings in your dial-up networking icon, particularly that the Primary DNS is
192.104.54.1 and that TCP/IP is the only selected protocol.

2.

Confirm that your Web browser is not using proxies; it should be set to “direct connection to
the Internet.”

3.

If you do log into a TCP/IP LAN, confirm that your LAN network IP address is being released.

To do so, connect to the FCC Network using dial-up networking, then click the Start button in
Windows 95/98 and select Run. Type winipcfg and press OK. If your IP address does not
begin with “192.104.”, then your LAN IP address is not being released. Click the Release All
button, or consult your LAN administrator.
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Receive an Internal Server error in the Web browser
1.

Confirm that the address entered in the location field is correct (http://www.fcc.gov/wtb/uls).

2.

Confirm that Java and JavaScript are enabled in your Web browser, and confirm that Cookies is
set to Accept All.

Help
For technical assistance with installing or using FCC software, contact the FCC Technical Support
Hotline at (202)-414-1250 (voice) or (202) 414-1255 (TTY). The FCC Technical Support Hotline is
available Monday through Friday from 8 a.m. to 6 p.m. Eastern Time. There are no weekend hours
and the hotline is closed all Federal holidays. All calls to the FCC Technical Support Hotline are
recorded.
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